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ПЕРЕЧЕНЬ РУССКО- И АНГЛОЯЗЫЧНЫХ СОКРАЩЕНИЙ 
И УСЛОВНЫХ ОБОЗНАЧЕНИЙ 

ИМС – интегральная микросхема 
КМОП – комплементарная пара, состоящая из двух транзисторов типа 

«металл-окисел-полупроводник» 
КП – контактная площадка 
КТТ – конструкторско-технологические требования 
МОП-транзистор – транзистор типа «металл-окисел-полупроводник» 
МЭМС – микроэлектромеханическая система, устройство, объединяющее 

в себе микроэлектронные и микромеханические компоненты 
САПР – система автоматизированного проектирования 
СнК – система на кристалле 
 
CIF – Caltech Intermediate Form, формат хранения данных топологии 

ИМС 
CSD – Contact Source Drain, контактные области истока/стока  

МОП-транзистора 
DRC – Design Rule Checking, контроль конструкторско-технологических 

требований 
EDA – Electronic Design Automation, автоматизация проектирования 

электронных приборов 
ERC – Electrical Rule Checking, контроль электрических проектных 

норм 
FOX – Field Oxide, толстый углубленный слой окисла 
GDSII – Graphic Data System II, формат хранения данных топологии 

ИМС 
GPDK – Generic Process Design Kit, обобщенная обучающая КМОП-тех-

нология компании Cadence 
LDD – Lightly Doped Drain, слаболегированные, мелкозалегающие об-

ласти истока/стока, контактирующие с каналом 
LVS – Layout Versus Schematic, сравнение топологической реализации 

схемы с ее исходным схемотехническим описанием 
OASIS – Open Artwork System Interchange Standard, формат хранения 

данных топологии ИМС 
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ВВЕДЕНИЕ 

Основными проблемами проектирования современных систем-на-
кристалле (СнК), содержащих миллионы полупроводниковых структур и мик-
росистем, объединяющих на одной подложке не только устройства обработки 
информации, но также микро- и нанодатчики (температуры, давления, ускоре-
ния, скорости потока, состава веществ и др.) и МЭМС (микродвигатели, мик-
ронасосы, микросмесители, микрозажимы и т. д.)  являются обеспечение без-
дефектности и сокращение времени проектирования. Учитывая крайне высо-
кую функциональную сложность ИМС и СнК, решение данных проблем воз-
можно лишь посредством использования различных алгоритмов оптимизации и 
методов автоматизации в системах компьютерного проектирования, опираю-
щихся на мощную вычислительную базу. 

Для реализации схемотехнического решения в кремниевом исполнении 
требуется редактор топологии (например, топологический редактор Cadence 
Virtuoso для Linux или L-Edit САПР Tanner EDA для Windows), средства 
размещения и трассировки блоков, контроль геометрических (DRC) и электри-
ческих (ERC) проектных норм, сравнение топологической реализации схемы с 
ее исходным схемотехническим описанием (LVS). Далее кристаллы наполня-
ются конечной физической топологией, информация записывается в файлы 
формата GDSII, которые передаются на завод-изготовитель. Завод изготавли-
вает набор шаблонов и реализует изделие в кремнии на своем оборудовании. 
Ответственность за функциональные характеристики ИМС полностью лежит на 
разработчике ИМС, в то время как кремниевая фабрика гарантирует качество 
технологического процесса. 

В методическом пособии описаны общие правила проектирования топо-
логии, оптимального расположения, согласования топологических фрагментов. 
Основное внимание уделено проектированию топологии на основе КМОП-
технологии, которая позволяет получить оптимальные динамические характе-
ристики ИМС – высокое быстродействие при минимальном потреблении мощ-
ности. Для ознакомления с функциональными возможностями топологического 
редактора Virtuoso Layout Editor компании Cadence [1] представлен маршрут 
проектирования топологии КМОП-инвертора начиная с этапа введения элек-
трической схемы и заканчивая оптимизированной топологией по результатам 
post-layout-моделирования. Описаны возможности графического интерфейса, 
проверка правил проектирования, экстракция электрической схемы из тополо-
гии, верификация топологии с электрической схемой, моделирование схем с 
учетом экстракции из топологии. 

Данное пособие является продолжением ранее выпущенной авторами се-
рии учебно-методических изданий, посвященных описанию методов и про-
граммных средств, предназначенных для технологического [2, 3], схемотехни-
ческого [4] и топологического [5] проектирования изделий микроэлектроники. 
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1. ОСНОВНЫЕ ПРАВИЛА ПРОЕКТИРОВАНИЯ ТОПОЛОГИИ 

Топология ИМС – множество геометрических фигур, расположенных в 
различных топологических слоях. Топологические слои объединяют фигуры, 
которые будут нанесены на один фотошаблон. Некоторое множество фигур в 
одном или в нескольких топологических слоях объединяется в топологическую 
группу. Топологическая группа кроме геометрических фигур может содержать 
в себе ссылки на другие группы, формируя иерархическое описание топологии 
ИМС. 

Топологический редактор позволяет либо непосредственно строить топо-
логию из геометрических фигур, либо формировать ее из параметризованных 
ячеек, содержащихся в библиотеке. Используя базу данных, редактор позволяет 
редактировать топологию ячеек в соответствии с конкретными требованиями. 
После разработки топологии отдельных фрагментов с помощью соответствую-
щей программы в диалоговом режиме осуществляется их размещение и трасси-
ровка межсоединений. После ввода описания топологии осуществляется ее ве-
рификация. 

Программа контроля проектных норм работает непосредственно с топо-
логией. Контроль осуществляется автоматически по значениям конструктор-
ско-технологических требований (DRC-контроль) для используемой техноло-
гии. Любые выходы за рамки ограничений помечаются непосредственно на 
изображении топологии либо в текстовом виде, выводимом на экран монитора. 

После завершения DRC-контроля программа восстановления электриче-
ской схемы преобразует описание топологии в описание электрической схемы в 
виде таблицы цепей (например, текстовое описание в Spice-формате). Эта таб-
лица передается в программу верификации логических и электрических схем, 
где проводится перекрестная проверка описанной схемы на логическом и топо-
логическом уровнях (LVS), а также повторное моделирование и верификация 
временных параметров. Затем таблица передается в программу контроля элек-
трических проектных норм (ERC-контроль). Эта программа дополнительно ис-
пользует еще и значения параметров транзисторов, полученные при восстанов-
лении электрической схемы из топологии. В результате ее работы идентифици-
руются все нераспознанные или неправильно соединенные элементы, а также 
все нарушения электрических проектных норм. 

Маршрут проектирования завершается преобразованием формата проект-
ного файла в промежуточную форму, используемую для передачи проекта на 
кремниевые фабрики, например в формат GDSII или OASIS. 

Проектирование топологии – процесс преобразования электрической или 
логической схемы в описание послойной реализации схемных компонентов 
(транзисторов, диодов, резисторов) и связей между ними в многослойной инте-
гральной структуре. 

Верификация топологии включает в себя контроль проектных норм, экс-
тракцию (восстановление) электрической схемы из описания топологии, срав-
нение с исходной схемой и средства анализа найденных нарушений. 
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Главная цель разработки топологии интегральных микросхем –
 эффективное использование площади кристалла. 
Однако необходимо учитывать, что характеристики ИМС, в частности, 

динамические, сильно зависят от паразитных емкостей и сопротивлений, опре-
деляемых топологией. Поэтому необходимо принимать компромиссные реше-
ния, которые учитывали бы оптимальное использование площади и получение 
хороших характеристик ИМС. В КМОП ИМС обычно используются прямо-
угольные конфигурации транзисторов, отличающиеся лишь различными отно-
шениями ширины к длине канала в зависимости от требуемого значения кру-
тизны характеристик транзистора [6]. 

1.1. Конструкторско-технологические требования 
к проектированию топологии 

Конструкторско-технологические требования (КТТ, DRC) к процессу из-
готовления проекта в кремнии накладывают ограничения, которые должны 
быть учтены при проектировании топологического рисунка ИМС, например 
требования минимальной ширины объектов, допустимых технологией, требо-
вания на точные размеры объектов, требования на минимальные зазоры. 

Ниже приведены КТТ (не полностью) для обобщенной обучающей 
КМОП-технологии компании Cadence (GPDK, Generic Process Design Kit) 
с n-карманом и шестью уровнями алюминиевой металлизации. 

Карманы к подложке (n-карман, NWELL; р-карман, PWELL) (рис. 1.1, 
а): 

1.1 – минимальная ширина кармана – 1 мкм; 
1.2 – минимальный интервал между карманами с разными потенциала-

ми – 1 мкм; 
1.3 – минимальный интервал между карманами с одинаковым потенциа-

лом – 0 или 1 мкм; 
1.4 – минимальный интервал между карманами различного типа (если оба 

присутствуют) – 1 мкм. 
Активная область (OXIDE) (рис. 1.1, б): 
2.1 – минимальная ширина – 0,4 мкм; 
2.2 – минимальное расстояние между активными областями – 0,3 мкм; 
2.3 – минимальное расстояние активных областей исток/сток от края кар-

мана – 0,5 мкм; 
2.4 – минимальное расстояние активного слоя подложка/карман от края 

кармана – 0,5 мкм; 
2.5 – минимальный интервал между активными областями различного ле-

гирования – 0 или 0,3 мкм. 
Поликремний (POLY) (рис. 1.1, в): 
3.1 – минимальная ширина – 0,18 мкм; 
3.2 – минимальный интервал – 0,3 мкм; 
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3.3 – минимальное перекрытие поликремниевым (ПК) затвором активной 
области – 0,2 мкм; 

3.4 – минимальное расстояние ПК от края активной области – 0,4 мкм; 
3.5 – минимальное расстояние между ПК и активной областью – 0,2 мкм. 
Области п- и р-типа проводимости (n- и р-канальные области, NIMP, 

PIMP) (рис. 1.1, г): 
4.1 – минимальное расстояние между канальной областью и затвором, 

чтобы гарантировать адекватную ширину – 0,4 мкм; 
4.2 – минимальное перекрытие канальной областью активной области –

 0,2 мкм; 
4.3 – минимальное перекрытие канальной областью контакта – 0,2 мкм; 
4.4 – минимально допустимые ширина и интервал – 0,4 мкм. 
Простой контакт к ПК (CONT) (рис. 1.1, д): 
5.1 – точный размер контакта к ПК – 0,2×0,2 мкм2; 
5.2 – минимальное перекрытие ПК контакта – 0,2 мкм; 
5.3 – минимальное расстояние между контактами – 0,2 мкм. 
Простой контакт к активному слою (CONT) (рис. 1.1, е): 
6.1 – точный размер контакта – 0,2×0,2 мкм2; 
6.2 – минимальное перекрытие контакта активной областью – 0,2 мкм; 
6.3 – минимальное расстояние между контактами – 0,2 мкм; 
6.4 – минимальное расстояние между контактом и затвором транзистора –

 0,2 мкм. 
 

 
Рис. 1.1. КТТ к проектированию топологии: 

а – карман к подложке; б – активная область; в – поликремний; г – области n- и p-типа 
проводимости; д – простой контакт к ПК; е – простой контакт к активному слою 
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1.2. Файловые форматы хранения данных топологии ИМС 

Традиционно информация о топологии ИМС хранится в файле, имеющем 
специальный формат. 

Промежуточная форма представления данных CIF2.0 (сокращение от 
«Caltech Intermediate Form»), разработанная в Калифорнийском технологиче-
ском институте, является средством описания графических элементарных групп 
(характеристик фотошаблона). Файлы в форме CIF создаются средствами 
САПР (топологическими редакторами) на базе других форм представления 
данных таких как символический язык геометрической структуры. Идея, поло-
женная в основу этой формы записи, состоит в символьном описании каждого 
геометрического объекта с достаточной степенью точности. 

Независимо от метода проектирования топологии полученные проекты 
преобразуются в форму CIF, являющуюся промежуточной формой представле-
ния данных, перед следующей трансляцией проекта применительно к различ-
ным формам выходных устройств генерации изображений. 

Наиболее распространенной формой представления данных топологии 
является GDS II (сокращение от «Graphic Data System II») – шестнадцатерич-
ный формат файлов баз данных, являющийся де-факто промышленным стан-
дартом для обмена данными по интегральным схемам и их топологиям. Данный 
формат описывает плоские геометрические формы, текстовые метки и иную 
информацию в иерархической форме. Данные могут использоваться для обмена 
между различными САПР или для создания фотошаблонов. Необходимо отме-
тить, что файл в формате GDS II является кроссплатформенным. Владельцем 
формата является компания Cadence. Более современным форматом, который 
может заменить GDS II, является OASIS. 

 
Спецификация топологических слоев. Каждый простейший элемент то-

пологии, который является геометрической фигурой (многоугольник, прямо-
угольник, проводник), должен быть обозначен путем точного указания техно-
логического фотошаблона, к которому он относится (табл. 1.1). 

 
Таблица 1.1 

 
Условное обозначение топологических слоев в форматах CIF2.0 и GDSII 

Топологический слой Обозначение слоя 
в формате CIF в формате GDSII 

Активная область Oxide 1 
p-карман Pwell 18 
n-карман Nwell 2 

Поликремний Poly 3 
Контакт Cont 6 

Первый слой металлизации Metal1 7 
Межслойный контакт Via1 8 

Второй слой металлизации Metal2 9 
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В формате CIF для спецификации слоя используется сокращенное на-
именование, а в формате GDSII – номер слоя. Наименования слоя или его но-
мера используются в целях повышения четкости файла и для исключения необ-
ходимости согласования с многочисленными разработчиками и изготовителя-
ми. 

1.3. Правила построения и согласования параметров 
топологии элементов интегральных микросхем 

Интегральная технология позволяет получить высокую степень согласо-
ванности однотипных элементов. Однако для этого требуется применение спе-
циальных топологических методов, которые минимизируют негативные рассо-
гласующие факторы, сопутствующие процессу изготовления и эксплуатации 
ИМС. Основные причины рассогласования топологических элементов ИМС и 
способы их устранения приведены в табл. 1.2 [7]. 
 

Таблица 1.2 
 

Причины рассогласования топологических элементов и способы их устранения 
Причина Источник Способ устранения 

Геометрические 
погрешности 

Различная геометрия 
элементов 

Разделение элементов на одинаковые сегменты 

Механические 
напряжения 

Внешнее механиче-
ское воздействие на 
кристалл, 
корпусирование 

Оптимальное расположение и ориентация на кри-
сталле. Оптимальная форма и размер кристалла 

Градиент 
механических 
напряжений 

Минимизация расстояния между элементами и их 
оптимальное расположение на кристалле. Исполь-
зование топологии элементов с общим центром при 
размещении элементов 

Изменение 
геометрии 
элементов 

Зернистость и дефекты Оптимальный выбор размеров, ориентации и фор-
мы элементов 

Смещение масок Разделение согласованных элементов на сегменты 
одинаковой геометрии 

Неравномерность 
травления 

Добавление фиктивных элементов по краям рабо-
чих элементов 

Генерация 
напряжения 

Термоэлектрический 
и пьезоэлектрический 
эффекты 

Разделение элементов (резисторов) на четное число 
сегментов с соединением в различных 
направлениях 

Изменение 
параметров 
элементов 

Наличие соседних 
структур 

Оптимальное расположение на кристалле относи-
тельно соседних диффузионных и поликремниевых 
структур 

Наличие контактов над 
рабочими областями 

Избегание расположения контактов и проводников 
над затворами и телом резисторов, конденсаторов 

Прочие Электростатическое 
взаимодействие 

Использование экранирования, оптимальный выбор 
концентрации примесей и материалов слоев 

Модуляция 
напряжением 
Инжекция заряда 
Диэлектрическая 
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поляризация 
Ниже представлены основные правила построения согласованных эле-

ментов. 
1. Согласованные элементы должны состоять из идентичных сегментов, 

организованных в массив. 
2. Все сегменты в массиве согласованных элементов должны иметь оди-

наковую ориентацию. 
3. Массивы сегментов согласованных элементов должны иметь мини-

мально возможное расстояние между геометрическими центрами или (жела-
тельно) общий центр. 

4. Следует принять меры по обеспечению равных условий для краевых и 
внутренних сегментов массива. 
 

Размещение согласованных элементов в массив с общим центром 
Согласованные элементы следует разделять на идентичные сегменты. 

Сегменты должны быть расположены симметричным образом в виде массива 
так, чтобы геометрический центр элемента находился на пересечении осей 
симметрии массива. 

Целесообразно размещать два элемента так, чтобы у них были общие оси 
симметрии. В этом случае геометрические центры этих двух элементов совпа-
дут (общий центр), что будет соответствовать нулевому расстоянию между 
элементами (рис. 1.2). 

При совпадении геометрических центров исключается влияние рассогла-
сующих факторов, связанных с наличием на кристалле разного рода градиентов 
параметров (градиентов толщин окисла, механических напряжений, температу-
ры и т. д.). 
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Рис. 1.2. Примеры размещения элементов с общим центром 

При построении массива сегментов согласованных элементов с общим 
центром должны выполняться следующие правила. 

1. Совпадение. Геометрические центры согласованных элементов должны 
совпадать. 

2. Симметрия. Массив сегментов должен быть симметричен вокруг обеих 
Х- и Y-осей. Эта симметрия должна быть результатом размещения сегментов в 
массиве, а не симметрии индивидуальных сегментов. 

3. Равномерность. Сегменты каждого согласуемого элемента должны 
быть распределены по массиву настолько равномерно, насколько это возможно. 

4. Компактность. Массив должен быть настолько компактным, насколь-
ко это возможно. В лучшем случае он должен быть почти квадратным. 

На рис. 1.3 приведены примеры возможного построения массивов с об-
щим центром из 2, 3 и 4 элементов с различными отношениями номиналов. 

 
A B B A 

A B C C B A 
A B C D D C B A 

A B A A B A 
A B A B A A B A B A 

A A B A A B A A 
A B C A B C C B A C B A 

A B C D D C B A A B C D D C B A 
A A B A A A A B A A A A B A A A A B A A 

Рис. 1.3. Примеры организации согласованных элементов с общим центром 

Чем более компактным будет выполнено размещение, тем менее восприим-
чивыми станут согласованные элементы к нелинейному изменению параметров. 

Двумерный массив с общим центром обеспечивает более высокую сте-
пень симметрии. Размещения этого вида называются размещениями с перекре-
стными связями сегментов (рис. 1.4). 

 

 
Рис. 1.4. Примеры построения массивов с перекрестными связями 
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Размещение с перекрестными связями является компактным и удовлетво-
ряет правилу ориентации, т. е. два сегмента, принадлежащих элементу в согла-
сованной паре, ориентированы в противоположных направлениях. 

Размещение с перекрестными связями обеспечивает лучшую степень со-
гласования, чем одномерные массивы, прежде всего из-за его компактности и 
равномерности. 
 

Уменьшение влияния механического напряжения и его градиента 
После корпусирования в кристалле возникают дополнительные механи-

ческие напряжения, которые могут вызвать рассогласование элементов в пре-
цизионных блоках. Механическое напряжение и его градиент минимальны в 
центре кристалла и в серединах его сторон, а максимальны в углах кристалла. В 
середине более длинной стороны механическое напряжение ниже, чем в сере-
дине короткой. Допустимые места расположения согласованных элементов на 
кристалле показаны на рис. 1.5. 
 

 
Рис. 1.5. Допустимые места расположения согласованных элементов на кристалле 

Для уменьшения влияния механического напряжения и его градиента 
следует придерживаться следующих правил: 

– согласованные элементы необходимо располагать на кристалле в местах 
с малым механическим напряжением и его градиентом (центр и середины сто-
рон кристалла) (см. рис. 1.5); 

– при выборе геометрии кристалла следует учитывать, что удлиненный 
кристалл имеет более высокие уровни напряжений, чем квадратный кристалл 
той же площади. При этом кристаллы с большей площадью обладают более вы-
сокими уровнями напряжений; 

– согласованные элементы необходимо ориентировать вдоль осей с ми-
нимальной пьезочувствительностью (рис. 1.6). 
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Рис. 1.6. Расположение осей <110> с минимальной пьезочувствительностью 

для пластины с ориентацией <100> 

Уменьшение влияния температурного градиента. Наличие на кристал-
ле мощных источников тепловыделения приводит к рассогласованию элемен-
тов из-за ненулевых значений температурных коэффициентов и термоэлектри-
ческого эффекта. 

Температурный градиент имеет максимальное значение вблизи перимет-
ра источника тепла. Оси симметрии тепловых распределений определяются 
корпусом и положением мощного элемента на кристалле. Приводимые ниже 
рекомендации позволяют уменьшить влияние температурных градиентов на 
степень согласования элементов. 

Для уменьшения влияния температурного градиента необходимо: 
– использовать четное число сегментов в резисторах, применяя соедине-

ние, компенсирующее термоэлектрический эффект (рис. 1.7); 
– ориентировать оси симметрии массивов сегментов вдоль осей симмет-

рии распространения тепла, т. е. перпендикулярно изотермам (рис. 1.8); 
– ориентировать более протяженные сегменты в согласованных элемен-

тах вдоль осей симметрии распространения тепла (см. рис. 1.8). 
 

 
 

 а б 

Рис. 1.7. Соединение резисторов: 
а – с парной компенсацией термоэлектрического эффекта; б – недопустимое соединение 
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Оптимальные варианты размещения на топологии согласованных элемен-
тов учитывают как влияние источника тепла, так и влияние механических на-
пряжений (см. рис. 1.8). 
 

 
Рис. 1.8. Оптимальные варианты размещения согласованных 

элементов на кристалле с источником тепла 

Основным способом уменьшения электростатического взаимодействия 
является электростатическое экранирование, которое заключается в размеще-
нии между источником паразитного поля и чувствительным элементом экрана 
из проводящего слоя (рис. 1.9). Для уменьшения электростатического взаимо-
действия с подложкой и сторонними шинами необходимо: 

– размещать карман под поликремниевыми и диффузионными резистора-
ми, а также под нижней обкладкой конденсатора; 

– размещать металлический экран между согласованными резисторами и 
конденсаторами, и шинами, проходящими в верхних слоях металла. 

Наиболее эффективно полное экранирование элемента с использованием 
как кармана под элементом, так и металлического экрана над элементом. 

Экранирующие проводники обычно соединяют с узлами, потенциал в ко-
торых наиболее близок к потенциалу на экранируемом элементе либо к анало-
говой земле или питанию. 

Электростатическое экранирование позволяет также уменьшить влияние 
ряда паразитных эффектов, связанных с инжекцией заряда, поверхностной ин-
версией и т. п. 
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Рис. 1.9. Пример электростатического экранирования поликремниевого резистора 

Особенности пересечения металлом согласованных резисторов 
При небольшом количестве уровней металлизации (технологии с одним-

двумя металлами), как правило, невозможно размещение экрана над резистора-
ми. В этом случае: 

– не рекомендуется пересечение сегментов согласованных резисторов 
проводниками, не связанными с их построением; 

– допускается пересечение металлическими шинами с потенциалом, 
близким к локальному потенциалу резисторов в месте пересечения; 

– необходимо обеспечить равные условия по количеству, геометрии и 
месту пересечения для всех сегментов согласованных резисторов (рис. 1.10); 

– желательно пересекать резисторы в специально выделенных низкоом-
ных удлиненных областях контакта к резистору (рис. 1.11). 
 

 
Рис. 1.10. Пересечение металлом согласованных резисторов 
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Рис. 1.11. Пересечение резисторов шинами металла по низкоомным областям 

Уменьшение влияния соседних структур на согласование элементов 
Скорости травления и диффузии в локальных областях кристалла зависят 

от взаимного расположения элементов, что может явиться причиной рассогла-
сования элементов. 

Для уменьшения технологического влияния соседних элементов необхо-
димо соблюдать следующие правила: 

– области диффузии сторонних элементов должны располагаться вдали от 
каналов согласованных транзисторов, по крайней мере на расстоянии, большем, 
чем удвоенная глубина перехода диффузии; 

– p-МОП-транзисторы (для подложки p-типа) должны быть помещены на 
значительном расстоянии от границ окружающего их n-кармана; 

– элементы, которые имеют высокую степень согласования, должны ис-
пользовать фиктивные сегменты по краям массива (рис. 1.12 и 1.13); 

– не рекомендуется использовать в качестве фиктивного сегмента непре-
рывное поликремниевое кольцо для поликремниевых элементов; 

– недопустимо размещать контакты над затворами МОП-транзисторов; 
 

 
Рис. 1.12. Пример построения фиктивных сегментов для согласованных резисторов 
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Рис. 1.13. Пример построения фиктивных сегментов для согласованных конденсаторов 

1.4. Проектирование шин и размещение блоков 
в смешанных (аналогово-цифровых) схемах 

При проектировании аналогово-цифровых интегральных микросхем 
предъявляются особые требования к трассировке шин питания и общей шины 
(«земли»), а также к взаимному размещению блоков, целью которых является 
минимизация взаимного влияния блоков. 

 
Проектирование шин питания 
При проектировании шин питания и общей шины рекомендуется: 
– общую шину и шину питания выполнять достаточно широкими и ис-

пользовать по возможности слой с наименьшим поверхностным сопротивлени-
ем (как правило, это верхний слой металлизации); 

– минимизировать число переходов с одного уровня металлизации на 
другой; 

– не допускать использования более высокоомных «подныров» (из поли-
кремния и т. п.). 

– разделять источники питания цифровых и аналоговых блоков; 
– проводить питающие шины к различным аналоговым блокам схемы 

раздельно, объединять шины можно непосредственно у КП кристалла; 
– не допускать большой плотности тока (для предотвращения разрушения 

шин из-за электромиграции алюминия Al плотность тока должна быть не более 
1–2 мА/мкм2); 
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– обеспечить одинаковый потенциал в точках контактирования питающих 
шин к согласованным элементам, что достигается соответствующим выбором 
длины и ширины шины; 

– разделять аналоговые и цифровые шины общей шиной. 
Для уменьшения высокочастотных составляющих в напряжении питания 

часто используют RC-фильтры. Однако это может приводить к значительным 
потерям мощности из-за падения напряжения на резисторе. Другим методом 
является RLC-метод, который состоит во включении между шиной земли и пи-
тания последовательного RLC-контура (рис. 1.14). 
 

 
Рис. 1.14. RLC-метод уменьшения высокочастотных помех 

между общей шиной и шиной питания 

 
Размещение блоков 
При размещении блоков на кристалле выделяют области расположения 

цифровых и аналоговых блоков (рис. 1.15). 
Для минимизации шумов по подложке со стороны цифровых блоков, ме-

жду цифровыми и аналоговыми блоками используют разделительную полосу 
с контактированием к шине питающего подложку напряжения. Разделительная 
полоса состоит из трех линий, центральная из которых является глубокой диф-
фузией (карман) и предназначена для разделения низкоомных слоев поверхно-
сти подложки. 

Цифровые и аналоговые блоки должны быть окружены охранными коль-
цами с контактированием к отдельным цифровым и аналоговым шинам пита-
ния соответственно. 
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Рис. 1.15. Пример компоновки на кристалле цифровых и аналоговых блоков 

1.5. Правила проектирования топологии Мида – Конвей 

Основной тенденцией при проектировании ИМС является постоянное 
уменьшение минимального расстояния, в пределах которого может быть дос-
тигнуто успешное формирование элементов на пластине. При проектировании 
ИМС задаются не абсолютные размеры, а используются единицы, кратные не-
которому параметру размера, обозначаемому λ. Этот параметр приблизительно 
равен максимальному значению случайного смещения границы топологическо-
го элемента, которое может возникнуть при его формировании на пластине. 
Наряду с другими факторами параметр λ ограничивает ширину проводника. 
Если она будет меньше 2λ, то так как нельзя гарантировать положение границы 
проводника с точностью до λ, границы фактически могут попасть в одно и то 
же место, и тогда ширина проводника станет равной нулю. Технологический 
уровень изготовления ИМС характеризуется именно этим параметром, значе-
ние которого за последние десять лет изменялось следующим образом: (2–1,5–
1,0–0,7–0,5–0,35–0,18–0,08) мкм. 

Важным шагом на пути упрощения процесса проектирования топологии 
ИМС и ее конвертирования на новые проектные нормы явились правила, раз-
работанные К. Мидом и Л. Конвей. Следуя им, проектировщик должен быть 
уверен, что его проект будет реализован производителями n-МОП ИС. При вы-
полнении этих правил в топологии не должна измениться связность проводни-
ков, даже если все границы сдвинутся независимо друг от друга на любые рас-
стояния вплоть до λ, но не включая его. 

Правила проектирования топологии Мида – Конвей: 
1. Минимальная ширина проводников. Проводники в поликремниевом и 

диффузионном слоях должны иметь ширину не менее 2λ. Ширина металличе-
ских проводников должна составлять, по крайней мере, 3λ (рис. 1.16). 
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Рис. 1.16. Правила расположения проводников 

2. Минимальное расстояние между проводниками. Промежутки между 
поликремниевыми проводниками должны составлять 2λ, а между диффузион-
ными и металлическими проводниками – 3λ. Поликремниевые и диффузионные 
проводники, не предназначенные для формирования транзисторов, должны 
быть разнесены, по крайней мере, на λ (см. рис. 1.16). 

3. Формирование транзисторов. Поликремниевый проводник должен вы-
ступать за пределы диффузионной области на 2λ. Несоблюдение этого правила 
может привести к короткому замыканию стока и истока (рис. 1.17). 
 

 
Рис. 1.17. Правило формирования транзистора 

4. Формирование контактов. Контакты выполняются в виде перекры-
вающихся квадратов со стороной 4λ в каждом из контактирующих слоев. 
В центре этого квадрата выполняется контактное окно в виде квадрата со сто-
роной 2λ (рис. 1.18). 
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Рис. 1.18. Контакт слоев металл – поликремний 

1.6. Особенности проектирования топологии пассивных компонентов 

Согласование интегральных резисторов 
Резисторы, которые необходимо согласовать, разделяются на сегменты с 

одинаковой геометрией и объединяются в массивы. 
Сегменты согласованных резисторов должны содержать не менее 5 квад-

ратов, обычное число квадратов в сегменте около 20. 
Сопротивление, соответствующее дробному числу сегментов, предпочти-

тельно получать последовательно-параллельным соединением сегментов. 
Желательно использовать максимально возможную в заданных условиях 

ширину квадрата резистора для получения большей степени согласования. 
Для построения согласованных резисторов необходимо: 
– выполнять согласованные резисторы из одинакового материала; 
– ориентировать согласованные резисторы в одинаковом направлении; 
– использовать размещение с общим центром для массивов сегментов со-

гласованных резисторов; 
– использовать фиктивные сегменты на краях массива; 
– подключать согласованные резисторы так, чтобы исключить термоэлек-

трические эффекты; 
– располагать согласованные резисторы в областях с низким механиче-

ским напряжением; 
– располагать согласованные резисторы вдали от мощных источников 

тепла. 
 

Согласование интегральных конденсаторов 
Оптимально согласованные конденсаторы обеспечивают наилучшую сте-

пень согласования по сравнению с другими интегральными элементами. 
Конденсаторы, подлежащие согласованию, разделяются на квадратные 

сегменты, которые объединяются в массивы. Массивы сегментов согласован-
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ных конденсаторов размещаются по двумерным схемам с общим центром (в 
частности, можно использовать топологию с перекрестными связями 
сегментов). 

Желательно использовать максимально возможную в заданных условиях 
емкость конденсатора для достижения наилучшей степени согласования. 

Допускается только параллельное соединение сегментов в согласованных 
конденсаторах, так как при последовательном соединении значительную по-
грешность вносят паразитные емкости нижних обкладок. В связи с этим полу-
чение емкости с дробной частью емкости сегмента затруднено. 

В прецизионных схемах нежелательно использовать нитридные и окси-
нитридные диэлектрики между обкладками конденсатора из-за их подвержен-
ности диэлектрической поляризации. 

Для построения согласованных конденсаторов необходимо: 
– использовать квадратные сегменты в матрицах согласованных конден-

саторов; 
– использовать большие по площади конденсаторы; 
– использовать размещение с перекрестными связями (с общим центром) 

в массиве сегментов согласованных конденсаторов; 
– размещать фиктивные конденсаторы вокруг внешнего края массива; 
– использовать электростатическую защиту для согласованных конденса-

торов; 
– уменьшать емкости проводников, соединяющих согласованные конден-

саторы; 
– не проводить металл по согласованным конденсаторам, за исключением 

электростатической защиты; 
– использовать диэлектрики из окисла кремния вместо нитридных для ис-

ключения влияния эффектов диэлектрической поляризации; 
– располагать конденсаторы в областях с низким градиентом механиче-

ского напряжения; 
– располагать согласованные конденсаторы вдали от мощных источников 

тепла. 
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2. ПРОЕКТИРОВАНИЕ ТОПОЛОГИИ КМОП ЗАКАЗНЫХ ИМС 

К классу полностью заказных ИМС относят схемы, реализующие проек-
ты частного применения. Такими проектами могут быть однокристальные мик-
ропроцессорные ИС, ИМС, реализующие быстрое преобразование Фурье, спе-
циальные сопроцессоры, процессоры и т. п. Можно говорить, что такие проек-
ты содержат произвольные логические построения. Заказные ИМС проектиру-
ются снизу вверх (от проектирования логического элемента до функциональной 
реализации). При такой методологии достигаются оптимальные параметры на 
каждом иерархическом уровне представления проекта. В качестве технических 
показателей заказных ИМС используются тактовая частота работы, площадь 
кристалла, на котором реализован проект, мощность рассеяния на единицу 
площади кристалла, степень интеграции [8]. 

В КМОП ИМС благодаря экстремальным и фиксированным значениям 
логических уровней (U(0) = VSS, U(l) = VDD), не зависящим от параметров 
транзисторных структур (крутизна, пороговое напряжение) и, следовательно, от 
их топологии, отпадает необходимость топологического расчета на основе ста-
тических требований. Обусловленную этим свободу выбора можно использо-
вать для проектирования КМОП ИМС с топологией, которая позволяет полу-
чить оптимальные динамические характеристики – высокое быстродействие 
при минимальном потреблении мощности. 

Для минимизации потребляемой мощности необходимо уменьшать как 
отношение W/L, так и абсолютное значение длины канала. При расчете геомет-
рических размеров транзистора длина его канала выбирается равной мини-
мально допустимому значению – минимально допустимой ширине поликрем-
ния на n+-, р+-области. Ширину канала определяют исходя из требований, 
предъявляемых к крутизне. 

Топология МОП-транзистора с каналом р-типа по площади приблизи-
тельно вдвое больше, чем МОП-транзистора с каналом n-типа. Такая разница 
обусловлена необходимостью компенсации различия в подвижности дырок и 
электронов в тех схемах, где нужна согласованность быстродействия элементов 
схемы. Если в некоторых конкретных применениях согласование быстродейст-
вия несущественно, то площади транзисторов с различным типом проводимо-
сти каналов могут быть сделаны одинаковыми. 
 

Особенности КМОП-технологии 
Исторически сложилось так, что в производстве длинноканальных КМОП 

ИМС использовалась технология с карманами р-типа, которая требует мини-
мального числа технологических операций. КМОП-технология с карманами  
р-типа обеспечивает лучшую симметрию параметров n- и р-канальных транзи-
сторов. 

Однако в настоящее время для короткоканальных субмикронных транзи-
сторов используется технология с карманами n-типа. Она позволяет получать 
повышенные рабочие характеристики n-канальных МОП-транзисторов, кото-
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рые в этом случае изготавливаются в подложке без инверсии ее типа проводи-
мости. 

Базовый технологический маршрут изготовления КМОП ИС по субмик-
ронным нормам с n-карманом требует использования самосовмещенного поли-
кремниевого затвора для создания LDD-областей (слаболегированные, мелко-
залегающие области истока/стока, контактирующие с каналом, Lightly Doped 
Drain), имплантации мышьяка для n-канального транзистора или бора для 
р-канального транзистора в контактные области истока/стока (CSD, Contact 
Source Drain). 

Особое значение в современной КМОП-технологии имеет разграничи-
тельная прослойка (спейсер), которая выполняет роль самосовмещенной маски 
при имплантации ионов в контактные сток-истоковые области и при силицида-
ции этих областей в глубокосубмикронной технологии. Спейсер является эле-
ментом, определяющим последовательное сопротивление МОП-транзистора, 
короткоканальный эффект и эффект горячих носителей. 

КМОП-структура с индуцированными каналами формируется на слаболе-
гированной подложке р-типа (рис. 2.1, а). Окислением через маску нитрида 
кремния Si3N4 (нитрид кремния не окисляется, поэтому окисел прорастает и 
вверх, и вниз) получают разделительный слой SiO2 – толстый углубленный 
слой окисла (FOX, Field Oxide) и удаляют Si3N4 (рис. 2.1, б, в). Границы разде-
лительных слоев образуют так называемые окна, определяющие места распо-
ложения будущих транзисторов. 

Следующая операция – легирование канала (рис. 2.1, г) – применяется для 
корректировки порогового напряжения и снижения напряжения прокола. Далее 
формируют подзатворный оксид кремния (рис. 2.1, д), наносят на него слой по-
ликремния и получают рисунок затворов и поликремниевых проводников. 

Ионным легированием без дополнительной маски формируют мелкозале-
гающие и слаболегированные истоки и стоки (LDD-области, п- и р-области) 
(рис. 2.1, е). Наличие LDD-области дает возможность увеличить напряжение 
питания на 30 % и уменьшить влияние горячих носителей. 

При формировании областей истоков и стоков ранее сформированный за-
твор служит маской для доноров или акцепторов. В результате происходит са-
мосовмещение краев областей истока и стока с краями поликремниевого затво-
ра. Самосовмещение обеспечивает минимальные емкости затвор – исток, 
затвор – сток и высокое быстродействие транзистора. 

Далее, при последующей имплантации, для создания контактных n+- и 
р+-областей (CSD-области) происходит совмещение с краем спейсера 
(рис. 2.1, ж, з). Так как сопротивление поликремния весьма высокое, то вместо 
него для получения затворов и проводников иногда используют силициды ту-
гоплавких металлов, имеющие на порядок меньшее удельное сопротивление 
(2–4 Ом/м), или сами металлы (сопротивление менее 0,1 Ом/м). 
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Рис. 2.1. Базовый технологический маршрут КМОП-технологии 

2.1. Методы оптимизации топологии МОП-транзистора 

На рис. 2.2 показана базовая топология МОП-транзистора, который имеет 
длину канала (L) 0,2 мкм и ширину канала (W) 20 мкм. Диффузионные области 
истока и стока должны быть заполнены максимальным количеством контактов, 
чтобы уменьшить сопротивление соединения металлизации и диффузионной об-
ласти и максимально увеличить ток, который может протекать через контакты. 
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Рис. 2.2. Этапы формирования топологии МОП-транзистора 

Особенности, которые следует учитывать при проектировании топологии 
МОП-транзистора: 

– паразитные сопротивления истока и стока должны быть настолько низ-
кими, насколько это возможно; 

– следует минимизировать паразитные емкости; 
– парные элементы должны быть максимально согласованы. 
Согласно первому правилу разработчик должен учитывать, что диффузи-

онные области истока и стока имеют слоевое сопротивление. Только несколько 
относительных квадратов достигают сопротивления сотен ом: даже при токе в 
10 мкА возможно падение напряжения на милливольты. Поэтому, как показано 
на рис. 2.2, следует использовать множество контактов к областям истока и 
стока, чтобы избежать паразитных поперечных падений напряжения. Множест-
во контактов, помещенных на минимальном расстоянии друг к другу, придают 
поверхности металлических соединений бóльшую гладкость, чем при исполь-
зовании одного большого контакта. Такая топология предотвращает появление 
микротрещин в металле, которые могут стать источниками отказов [9]. 
 

Оптимизация топологии МОП-транзистора 
Транзисторы с большой шириной канала имеют высокое значение отно-

шения ширины канала к его длине. Разработка компактной топологии таких 
транзисторов не представляется возможной. Топология транзистора может 
быть изменена путем разбиения его на параллельно соединенные сегменты (от 
англ. fingers – «пальцы»). Например, транзистор с шириной канала 20 мкм и 
длиной 0,2 мкм соответствует параллельному соединению четырех транзисто-
ров с шириной канала 5 мкм и длиной 0,2 мкм (рис. 2.3). 
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Рис. 2.3. Разделение МОП-транзистора на сегменты 

На рис. 2.4 показана топология транзистора, разделенного на четыре сег-
мента. Такой вариант топологии имеет лучшее значение аспектного соотноше-
ния геометрии транзистора. 

 

 
Рис. 2.4. Топология МОП-транзистора, состоящего из четырех сегментов 

Для улучшения параметров быстродействия транзистора необходимо 
уменьшать значения его паразитных емкостей и сопротивлений. На рис. 2.5 по-
казана упрощенная схема возникновения паразитных емкостей истока, затвора 
и стока транзистора к подложке. 
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Рис. 2.5. Паразитные емкости МОП-транзистора 

Полная емкость Csb зависит от площади истока (AS) и периметра истока 
(PS). Точно так же полная емкость Cdb зависит от площади стока (AD) и пери-
метра стока (PD). Емкости Csb и Cdb включают компоненты, которые зависят от 
параметров диффузии. Значения AS, AD, PS и PD транзистора могут быть из-
влечены из топологии. Уменьшение емкости истока и стока позволяет улуч-
шить частотную характеристику транзистора. 

Транзисторы, разбитые на сегменты, имеют меньшее сопротивление 
(рис. 2.6). Такая конструкция обладает повышенным быстродействием. 

 

 
Рис. 2.6. Эквивалентное сопротивление и емкость поликремниевого затвора 
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Удельное сопротивление поликристаллического кремния в несколько раз 
выше, чем удельное сопротивление металла. Паразитные емкости между поли-
кремнием и подложкой, между металлом и поликремнием намного больше, чем 
паразитная емкость между металлом и подложкой. Следовательно, использова-
ние поликремния для межсоединений приводит к ухудшению частотных харак-
теристик транзистора (рис. 2.7, а), если не оптимизирована трассировка поли-
кремния. В варианте топологии на рис. 2.7, а используется поликремний и ме-
талл для соединения затворов. В варианте на рис. 2.7, б используется только 
металл для соединения. Вариант на рис. 2.7, с наиболее популярен для конст-
рукции с множеством контактов на затворе. Для улучшения производительно-
сти контакты затворов в топологии помещены вдали от транзисторов и парал-
лельно диффузии, чтобы увеличить расстояние между диффузией и поликрем-
нием. Транзистор в первом варианте будет обладать наихудшей частотной ха-
рактеристикой из-за дополнительных паразитных емкостей металл –
поликремний и поликремний – подложка. 
 

 
а 

б в 

Рис. 2.7. Варианты соединения поликремниевых затворов 

Защита от пробоя подзатворного диэлектрика. Подзатворный диэлек-
трик, который находится под поликремнием, имеет малую толщину. Если за-
ряд, накопленный на поликристаллическом кремнии, достигает высоких значе-
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ний, то он может привести к разрушению подзатворного окисла. Это явление 
называется «антенный эффект». 

Максимальная величина заряда, который может быть накоплен на поли-
кремнии, пропорциональна его площади. Таким образом, эффективным спосо-
бом предотвращения антенного эффекта в топологии является его учет в прави-
лах проектирования для соответствующей технологии. Для предотвращения 
возникновения антенного эффекта следует руководствоваться следующими 
правилами: 

– минимизировать использование поликремния для трассировки; 
– минимизировать использование поликремния для соединения логиче-

ских элементов. 
Возможно использование диодов для защиты от антенного эффекта. Од-

нако диоды эффективны только для его предотвращения в металлических ши-
нах и не помогают избежать эффекта в поликремнии. Причиной этого является 
то, что диоды формируются в диффузионной области, а поликремний осажда-
ется на подложку раньше, чем имплантация истока и стока. Следовательно, ди-
од не существует в то время, когда поликремний осажден на подложку. 

Помимо предотвращения антенного эффекта, следует принимать и другие 
меры защиты затворов: 

– не помещать контакты и межслойные контакты непосредственно над 
затвором транзистора; 

– избегать трассировки межсоединений над затворами критичных транзи-
сторов (рис. 2.8, а); 

– избегать трассировки межсоединений над рабочими областями критич-
ных транзисторов. 

 

 
 а б 

Рис. 2.8. Трассировка транзистора широкими шинами металла: 
а – нежелательный вариант, когда затвор перекрывается металлизацией; 

б – оптимальный вариант 
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Исключением для аналоговых схем является трассировка по активным 
областям несогласованным МОП-конденсаторов для минимизации длинных 
связей. В цифровых схемах допускается трассировка над рабочими областями 
транзисторов. 

2.2. Методы соединения и согласования МОП-транзисторов 

Различные варианты соединений транзисторов и их топологическая реа-
лизация представлены на рис. 2.9. Быстро распознать топологию логических 
элементов 2И-НЕ, 2ИЛИ-НЕ позволяет следующее правило: 

– для схемной реализации логического элемента 2И-НЕ необходимо два 
контакта к шине Питание («запитываются» два истока р-канальных транзисто-
ров) и один контакт к шине Земля («заземляется» один исток n-канального 
транзистора); для логического элемента 2ИЛИ-НЕ необходимо «одно питание – 
две земли». В топологической реализации вентилей используют три или более 
контактов к истоковым областям транзисторов для того, чтобы надежно соеди-
нить шины Питание и Земля [10]. 
 

 
Рис. 2.9. Варианты соединения транзисторов и их топологическая реализация 

На рис. 2.10 приведена топологическая реализация элемента 2И-НЕ. Изу-
чая топологию логического элемента, видим две группы контактов к истоковым 
областям р-канальных транзисторов (слева и справа две n-области для смеще-
ния кармана) и два вертикально расположенных вывода шины Питание, одну 
группу контактов к истоковой области n-канального транзистора (слева 
р-область для смещения подложки) и один вертикальный вывод шины Земля. 
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Рис. 2.10. Логический элемент 2И-НЕ: 

а – электрическая схема; б – топологическая реализация 

Согласование МОП-транзисторов. Как правило, n-канальные транзи-
сторы обеспечивают лучшую степень согласования, чем р-канальные при про-
чих равных условиях. 

МОП-транзисторы, которые необходимо согласовать, разделяются на 
сегменты, или пальцы, позволяющие построить компактный массив. Самый 
простой тип массива – размещение нескольких сегментов транзистора парал-
лельно. При этом допускается объединение общих истоков и(или) стоков. На 
рис. 2.11 показан пример топологии пары согласованных МОП-транзисторов с 
общим центром и фиктивными элементами. На рис. 2.12 показан пример топо-
логии пары согласованных МОП-транзисторов с перекрестными связями и 
фиктивными элементами. 

Для обеспечения лучшей степени согласования желательно выбирать 
максимально возможную для данного применения площадь затворов транзи-
сторов. 
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Рис. 2.11. Пример топологии пары согласованных транзисторов 

 
Рис. 2.12. Пример топологии пары согласованных транзисторов 

с использованием перекрестных связей 

Для построения согласованных МОП-транзисторов необходимо [11]: 
– использовать идентичную геометрию сегментов; 
– использовать по возможности большие по площади затворы транзисто-

ров; 
– ориентировать транзисторы в одинаковом направлении; 
– использовать компактное размещение согласованных транзисторов; 
– применять размещение с общим центром или с перекрестными связями 

сегментов; 
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– располагать фиктивные элементы по краям массива транзисторов; 
– размещать транзисторы в областях с низким градиентом механического 

напряжения; 
– размещать транзисторы вдали от мощных источников тепла; 
– не размещать контакты над затворами транзисторов; 
– не проводить металл через затворы транзисторов; 
– избегать размещения согласованных транзисторов рядом с элементами, 

имеющими глубокую диффузию; 
– соединять затворы транзисторов, набранных из сегментов, используя 

металлические связи. 

2.3. Защита от эффекта защелкивания в КМОП-структуре 

В интегральной КМОП-технологии существует потенциальная опасность 
взаимного расположения элементов, приводящего к образованию паразитных 
тиристорных структур. Типовой случай такой структуры приведен на рис. 2.13. 

Ток в p-n-p-n-структуре протекает от истока p-канального транзистора, 
подключенного к шине Питание, к истоку n-канального транзистора, подклю-
ченного к шине Земля. 

 

 
Рис. 2.13. Паразитная тиристорная структура в стандартной КМОП-технологии 

Критерии возможности проявления тиристорного эффекта. Опас-
ность проявления паразитного тиристорного эффекта возникает в случае, если 
выполняются следующие условия: 

– напряжение удержания паразитного тиристора меньше максимального 
напряжения питания: Uуд < Uп; 

– произведение коэффициентов усиления базового тока транзисторных 
p-n-p и n-p-n структур больше единицы: βpnpβnpn > 1. 
 

Методы защиты от включения паразитного тиристора 
 Тиристорного эффекта можно избежать, если не выполняются условия 

его возникновения, т. е. Uуд > Uп или βpnpβnpn < 1. 
Для выполнения условий целесообразно: 
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– располагать элементы, подверженные тиристорному эффекту, на боль-
шом расстоянии друг от друга; 

– располагать контакты к отрицательному и положительному питанию на 
минимальном расстоянии от активных элементов; 

– размещать двойные n+/p+-контакты на возможном пути протекания тока 
тиристора в местах подключения к отрицательному и положительному источ-
никам питания; 

– размещать охранные кольца вокруг и между структурами, которые в со-
вокупности могут образовать паразитный тиристор; 

– размещать структуры, чувствительные к защелкиванию, вдали от ис-
точников, приводящих к их включению; 

– располагать p- и n-канальные транзисторы зеркально друг относительно 
друга; 

– уменьшать токи, инжектируемые в подложку. 
Необходимая степень защиты от тиристорного эффекта во многом опре-

деляется местом его потенциального возникновения, а именно: 
– в узлах входа/выхода вокруг контактных площадок; 
– во внутренних блоках, расположенных вблизи контактных площадок, и 

внутренних блоках, имеющих непосредственную или емкостную связь с кон-
тактной площадкой; 

– во внутренних блоках, удаленных от контактных площадок и не имею-
щих с ними связей. 

Для защиты узлов входа/выхода от тиристорного эффекта, как правило, 
используются двойные охранные кольца, которые окружают структуры, обра-
зующие в совокупности паразитный тиристор. 

Двойные охранные кольца защищают собственно выходные узлы от ти-
ристорного эффекта. Для защиты окружающих и внутренних блоков полезно 
применять дополнительные охранные кольца вокруг всей выходной структуры. 

Для защиты внутренних блоков от включения тиристора используются 
технологические методы и специальные правила построения топологии. 

Двойные охранные кольца используются во внутренних блоках только в 
случае непосредственной или емкостной связи с контактной площадкой или 
при охране источников инжекции (диодов в прямом включении). 

При проектировании топологии необходимо придерживаться требований, 
которые предъявляются к допустимому расстоянию  от контакта к отрицатель-
ному или положительному питанию до границы активного элемента. При этом 
обеспечивается защита от включения паразитного тиристора. Это расстояние, 
как правило, указывается в проектных топологических нормах изготовителей 
микросхем. 

Увеличение сопротивления истоков в местах, подверженных тиристор-
ному эффекту (рис. 2.14, б) способствует увеличению напряжения удержания, 
что уменьшает вероятность проявления тиристорного эффекта. 
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Рис. 2.14. Пример топологии внутренних блоков: 
а – без специальной антитиристорной защиты; б – с увеличенным сопротивлением истоков; 
в – с использованием встречных двойных контактов; г – с использованием охранных колец 

Использование двойного контакта (рис. 2.14, в) – распространенный спо-
соб защиты от тиристорного эффекта во внутренних блоках. Самым эффектив-
ным способом является вариант с использованием замкнутых охранных колец 
(рис. 2,14, г). Он, как правило, применяется при построении аналоговых блоков 
и в местах, близких к вероятным источникам инжекции неосновных носителей 
(вблизи диодов и т. д.). 
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3. МАРШРУТ ПРОЕКТИРОВАНИЯ И ВЕРИФИКАЦИИ 
ТОПОЛОГИИ В ПРОГРАММНОМ КОМПЛЕКСЕ CADENCE 

Рассмотрим порядок формирования топологии (топологических слоев) 
инвертора по КМОП-технологии с n-карманом (по конструктивно-
технологическим проектным нормам 0,18 мкм универсальной библиотеки Ca-
dence gpdk с использованием топологического редактора Virtuoso системы 
компьютерного проектирования Cadence. Согласно выбранной технологии ми-
нимальная ширина канала МОП-транзистора равна 180 нм, поэтому минималь-
ная ширина поликремниевого затвора берется равной 180 нм. 

3.1. Компоновка электрической схемы 

На рис. 3.1 представлена электрическая схема КМОП-инвертора, вклю-
чающая наследуемые выводы Земля/Питание (gnd!/vdd!) для последующего 
адекватного распознавания их программой экстракции. На рис. 3.2 предложен 
тестовый модуль для проверки функционирования и определения ключевых 
параметров. 

При создании новой библиотеки проекта в Cadence на запрос Technology 
File for New Library необходимо выбрать пункт меню Attach to an existing 
techfile, затем указать необходимую технологическую библиотеку, в данном 
случае – gpdk. 
 

 
Рис. 3.1. Электрическая схема инвертора 
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Рис. 3.2. Тестовая схема инвертора 

Истоки р-канальных транзисторов и локальная n+-область n-кармана под-
ключаются к шине Питание. Истоки n-канальных транзисторов и локальная 
р+-область р-подложки подключаются к шине Земля. Таким образом n-карман и 
р-подложка изолированы друг от друга обратно смещенным р-n-переходом. 

3.2. Описание топологии на примере КМОП-инвертора 

На рис. 3.3 предложен вариант топологии КМОП-инвертора. Топология 
инвертора содержит транзисторы, параметры которых определены при модели-
ровании схемы. 

Представленная топология выполнена в стиле стандартных ячеек, кото-
рый часто используется для автоматической трассировки и размещения логиче-
ских элементов. Этот стиль можно также использовать для проектирования за-
казной топологии. Перечислим особенности такого проектирования: 

– топология разрабатывается так, чтобы элементы можно было соеди-
нить, расположив их рядом друг с другом; особенно это характерно для шин 
Питания и Земли; 

– топология проектируется таким образом, чтобы сигнал распространялся 
слева направо в одном уровне металлизации (от выхода к входу); 

– топология логических ячеек имеет одинаковые параметры расположе-
ния шин Питания и Земли для их совместного использования. 
Би
бл
ио
те
ка

 БГ
УИ
Р



 40

 
Рис. 3.3. Топология КМОП-инвертора 

Топологические слои 
Топологические слои (см. рис. 3.3) используются для определения распо-

ложения и размеров элементов и связей. Слои обычно отображаются различ-
ными цветами и различной заливкой (показаны в окне layer selection window –
 LSW) и определяются в файле display.drf. Файл display.drf расположен в папке с 
библиотекой gpdk. 

Фигуры в слое oxide используются для определения места, куда будет 
проводиться имплантация в подложке (исключая область, покрытую затвором) 
для формирования исток–стоковых областей каждого транзистора. 
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Фигуры в слое poly используются для определения участков поликрем-
ния, формирующих затворы каждого транзистора, а также для формирования 
коротких связей. 

Пересечение слоев oxide и poly определяет канал транзистора. Поскольку 
минимальный размер oxide = 0,4 мкм и poly = 0,18 мкм, это означает, что ми-
нимальная ширина канала транзистора = 0,4 мкм и минимальная длина канала 
транзистора = 0,18 мкм. 

В некоторых случаях слой oxide невозможно нарисовать в виде простого 
прямоугольника. Размер oxide при формировании исток–стоковых областей 
должен позволять разместить контакт, а размер транзистора может быть вы-
бран меньшим. В этом случае необходимо вырезать из слоя oxide необходимый 
сегмент в области пересечения с poly. 

Слой oxide также определяет области, которые будут легироваться для 
формирования контактов к подложке или карману. Для p--подложки, импланта-
ция должна быть p+-типа. Для n-кармана (место для формирования 
p-МОП-транзисторов), имплантация должна быть n+-типа.  
 

N-well области (карманы) 
P-МОП-транзисторы должны быть размещены в кармане n-типа. В тех-

нологии с карманом n-типа подложка для p-МОП-транзисторов формируется 
диффузией примеси n-типа в области подложки p-типа. Фигура в слое nwell оп-
ределяет области, в которых можно разместить p-МОП транзистор. 
 

Исток-стоковые области 
В топологии n+-область рисуется с помощью двух слоев nimp и oxide,  

р+ -область рисуется с помощью двух топологических слоев pimp и oxide. Сле-
дует заметить, что слои pimp и oxide не соответствуют реальной физической 
топологии, а рассматриваются как вспомогательные. Логическая операция AND 
(И) над слоями pimp и oxide позволит сформировать р+-область. 
 

Контакты 
Квадрат 0,2 мкм × 0,2 мкм, нарисованный в слое contact, позволяет ме-

таллу подсоединиться к исток–стоковым областям, к подложке или карману. 
Квадрат 0,2 мкм × 0,2 мкм, нарисованный в слое contact над областью 

poly, позволяет металлу подключиться к затвору и сформировать контакт к по-
ликремнию. 
 

Металлизация для трассировки Земли/Питания и сигнальных шин 
Фигуры в слое metal1 определяют области из алюминия, формирующие 

первый уровень металлизации. В данном примере metal1 используется для всех 
входов и выходов инвертора. 

Квадрат 0,2 мкм × 0,2 мкм в слое contact обеспечивает подключение ме-
тала в слое metal1 к поликремниевой трассировке в слое poly. 
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В технологии 0,18 мкм gpdk имеется 6 уровней металлизации (metal1, 
metal2, и т. д.). В инверторе нет необходимости их использовать, хотя для бо-
лее сложных схем применение их необходимо для формирования более ком-
пактной топологии. Очень часто один из слоев используют для вертикальной 
трассировки, а другой – для горизонтальной. 

Для межсоединения metal1 и metal2 используется квадрат в слое via1. 
Для соединения других слоев между собой используют соответствующий кон-
тактный слой межсоединений. Например, для соединения metal2 и metal3 ис-
пользуется слой via2. 
 

МОП-транзисторы 
P-МОП-транзистор формируется с использованием трех слоев pimp, 

oxide и poly. Первым рисуется топологический слой n-кармана. Далее рисуется 
слой pimp, меньших размеров активный слой (oxide) и поликремниевые затво-
ры (топологический слой poly). P-МОП-транзистор формируется с использова-
нием логических операций над слоями: (pimp) AND (oxide) AND (NOT(poly)). 
Длина (L) и ширина (W) канала определяются по границам пересечения топо-
логического слоя poly активного слоя oxide. Периметр транзистора определяет-
ся активным слоем. N-МОП-транзистор формируется аналогично с использова-
нием трех слоев: nimp, oxide и poly. 

В общем случае топология КМОП-инвертора с n-карманом строится в 
следующей последовательности: 

1) формируется топологический слой «р-подложка»; 
2) формируется топологический слой «n-карман» (nwell); 
3) в топологическом слое «n-карман» формируется топологический слой 

«р-канал» (pimp). Это р-канальные области транзистора и локальная область р-
типа на р-подложке для смещения подложки; 

4) формируется n-канальная область (nimp) – это n-канальные транзисто-
ры и локальная n-область к карману для смещения кармана; 

5) формируются области истока и стока n-МОП и р-МОП транзисторов с 
использованием активного слоя (oxide); 

6) формируются поликремниевые затворы (poly) и, если необходимо, по-
ликремниевые перемычки (небольшие отрезки poly, предназначенные для со-
единения затворов) и головки (лапти) к затворам с расчетом места под один 
(контакт poly-metal1) или два контакта (контакт poly-metal1 и контакт metal1-
metal2); 

7) в активных областях, затворах и в областях к подложке и карману 
формируются контактные области contact; 

8) формируется топологический слой металл-1 (metal1) (шины Земля, 
Питание, внутренние межсоединения, небольшие отрезки для организации 
межслойного контакта via1); 

9) формируются контактные области под второй металл (metal2); 
10) в вертикальном направлении прокладывается слой metal2. 
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3.3. Проектирование топологии в среде Virtuoso Layout Editor 

Для запуска редактора топологии Virtuoso Layout Editor необходимо 
создать новое представление проекта в менеджере библиотек (library 
manager). В окне Create New File выбираем Library Name = «название биб-
лиотеки, в которой расположена схема инвертора», Cell Name = «название 
схемы». В поле View Name вводим layout. В поле Tool выбираем Virtuoso. На-
жимаем OK. 

Появятся два окна. Одно из них называется Layer Selection Window 
(LSW). В окне LSW можно выбрать активный слой, установить видимые и ак-
тивные слои. Технологический файл определяет слои и цвета, которые доступ-
ны в LSW.  

Второе окно – редактор топологии (Virtuoso Layout Editing) (рис. 3.4), в 
котором с помощью фигур в различных слоях проектируется топология. 
 

 
Рис. 3.4. Рабочее окно программы Virtuoso Layout Editor 

Наиболее удобно пользоваться программой Virtuoso L (XL,GXL) Layout 
Editor, с помощью которой рекомендуется проектировать топологию. Для ее 
использования необходимо открыть электрическую схему и выбрать Tools → 
Design Synthesis → Layout XL, в окне Startup Option выбирается необходи-
мый параметр (создаем новое представление либо открываем имеющееся), по-
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сле чего откроется пустое окно программы Virtuoso XL Layout Editor и произой-
дет трансформация рабочего места (рис. 3.5). 
 

 

 
Рис. 3.5. Рабочее окно программы Virtuoso XL Layout Editor 

Как правило, библиотека проектирования содержит топологические пред-
ставления всех доступных компонентов в виде параметризованных ячеек, т. е. 
при изменении параметров компонентов (например, длины или ширины канала 
МОП-транзистора) соответствующим образом изменяется топология с перерас-
четом размеров. 

Для добавления компонентов выбирается команда Design → Get From 
Source. В появившемся окне Layout Generation Options при необходимости 
можно изменить требуемые параметры, затем следует нажать ОК. В редакторе 
топологии появятся транзисторы, четыре порта (пина) и квадратная область в 
слое boundary (граница ячейки). Если сделать активным какой-либо компонент 
в топологии, то подсветится соответствующий элемент электрической схемы, и 
наоборот (рис. 3.6, а). 
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а б 

Рис. 3.6. Программа Virtuoso XL Layout Editor: 
а – рабочее окно; б – вид панели для настройки слоев 

Для подсветки неподключенных связей выполняется команда 
Connectivity → Show Incomplete Nets. В появившемся окне следует отметить 
Select All и нажать OK. 
 

Настройка топологического редактора 
Перед началом проектирования топологии необходимо установить размер 

сетки по горизонтали и вертикали так, чтобы упростить процесс рисования и 
разработать более компактный дизайн. 

Для установки настроек дисплея выбирается команда Options → Display. 
Появится окно Display Option. Устанавливаются значения Minor Spacing = 0,1; 
Major Spacing = 0,1; X Snap Spacing = 0,01; Y Snap Spacing = 0,01. Далее па-
раметр Spacing может быть изменен в соответствии с текущими требованиями. 

Установки можно сохранить и восстановить позднее с помощью кнопок 
Save To и Load From соответственно. Возможен выбор места хранения настро-
ек: cellview, библиотека, технологическая библиотека или указанный файл. При 
сохранении в файл будут записаны настройки из Layout Editor Options и Display 
Options. По завершении следует нажать OK. 

Для изменения опций редактирования и поведения курсора выбирается 
команда Options → Layout Editor. В окне Layout Editor Option можно снять 
выделение с Gravity On. Эта опция отменяет «прилипание» курсора к объек-
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там, которые уже нарисованы. Некоторые разработчики считают эту опцию 
удобной. По завершении нажимается OK. 
 

Настройка топологических слоев 
Окно Layer Selection Window (LSW) (рис. 3.6, б) позволяет установить ак-

тивный слой (слой, в котором будут создаваться все элементы). Также можно 
выбрать видимые и выделяемые слои. 

Чтобы изменить видимость слоя, следует нажать по нему средней кноп-
кой мыши (scroll). Невидимый слой автоматически становится невыделяемым. 
Картинка возле слоя исчезнет и слой станет невидимым, имя слоя будет на се-
ром фоне, если слой станет невыделяемым. 

После изменений в LSW нажимается Window → Redraw для просмотра 
эффекта. Чтобы сделать все слои видимыми, нажимается кнопка AV (All 
visible). Кнопка NV, наоборот, сделает все слои, кроме активного, невидимыми. 
AS – сделает все слои выделяемыми. NS – сделает все слои невыделяемыми. 
Для выбора активного слоя используется левая кнопка мыши. 

 
Создание фигур и объектов 
Большинство фигур, используемых при проектировании, – это прямо-

угольники или многоугольники. Их размеры зависят от схемы и правил проек-
тирования. 

Для создания прямоугольника выбирается необходимый слой в LSW, за-
тем в редакторе выбирается Create → Rectangle или нажимается иконка Rec-
tangle. По нажатии клавиши F3 в появившемся окне можно ввести имя связи, 
которое присоединяется к фигуре. Можно оставить его пустым и ввести имя 
позже. Отметим, что задание имен помогает в процессе проверки топологии на 
соответствие электрической схеме. 

Для создания многоугольника необходимо выбрать слой в LSW, затем 
выбрать Create → Polygon или нажать на иконку Polygon. Если нажать клави-
шу F3, то появится окно, в котором можно ввести имя связи, ассоциирующееся 
с фигурой. Рекомендуется установить Snap Mode = Orthogonal. Опция Snap 
mode помогает контролировать способ рисования сегментов многоугольника. 

 
Создание портов (пинов) 
Для создания пина выбирается команда Create → Pin. После этого поя-

вится новое окно, в котором устанавливается Mode в shape pin. Новое окно 
Create Shape Pin заменит предыдущее. 

В поле Terminal Names вводится имя пина. Необходимо убедиться, что 
имя точно совпадает с именем в электрической схеме (с учетом регистра). Для 
уверенности рекомендуется открыть электрическую схему и проверить свойст-
ва связи. 

Можно включить опцию Display Pin Name, если необходимо видеть имя 
в топологии. Нажимается кнопка Display Pin Name Option для выбора вариан-
та отображения имени пина. 
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Затем определяется направление I/O type в соответствии с функцией пи-
на. Для питания и земли выбирается inputOutput. Затем выбирается необходи-
мый слой в LSW и рисуется соответствующая пину фигура. 

 
Выделение объектов 
Чтобы изменить параметры объекта, его необходимо сделать активным 

или выделить. Для выделения необходимо щелкнуть по объекту мышью. Для 
снятия выделения можно щелкнуть мышью в пустой области топологии. 

Для выделения нескольких объектов используется клавиша Shift. Для 
снятия выделения с одного или нескольких выделенных объектов используется 
клавиша Ctrl. 
 

Перемещение объектов 
Для передвижения объектов выбирается команда Edit → Move из основ-

ного меню или нажимается иконка Move. При нажатии F3 появится окно Move. 
После выделения объектов CIW будет предлагать ввести относительную точку 
передвижения. Объекты будут передвинуты соответственно передвижению от-
носительной точки. 

В окне Move есть опция Change To Layer. Она позволяет передвигать и 
изменять объект из одного слоя на другой без перерисовки самого объекта. Для 
этого выбирается функция Change To Layer, указывается необходимый слой и 
передвигается объект. 

Возможен поворот или отражение объекта нажатием на кнопки Rotate, 
Sideways и Upside Down в окне Move после ввода относительной точки. 
 

Копирование объектов 
Для копирования объекта выбирается команда Edit → Copy или исполь-

зуется иконка Copy. После появления окна Copy выделяются объекты для ко-
пирования. В CIW появится приглашение для ввода относительной (начальной) 
точки для копирования. 

Для копирования и вставки множества вариантов объектов вводится чис-
ло копий в поле Rows или Columns. 

В окне Copy есть опция Change To Layer. Она позволяет копировать и 
изменять слой объекта одновременно. Для этого выбирается функция Change 
To Layer, указывается необходимый слой и копируется объект. 

Также можно поворачивать или отображать объект нажатием на кнопки 
Rotate, Sideways и Upside Down в окне Copy после ввода относительной точки. 

 
Растягивание объектов 
Для растягивания объекта выбирается команда Edit → Stretch в меню 

или нажимается иконка Stretch. Затем выделяется часть объекта для изменения 
и указывается точка назначения. Объект будет изменен в соответствии с изме-
нением относительной точки. 
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Объединение объектов 
Для объединения объектов в один топологический слой они выделяются, 

и выполняется команда Edit → Merge. 
Удаление объектов 
Для удаления объекта выбирается команда Edit → Delete или нажимается 

клавиша Delete. 
Сохранение топологии 
Для сохранения проекта выбирается команда Design → Save или нажима-

ется иконка Save. 

3.4. Проверка топологии на соответствие правилам проектирования 

Программа контроля проектных норм работает непосредственно с топо-
логией. Контроль осуществляется автоматически по значениям конструктор-
ско-технологических требований (DRC-контроль) для используемой КМОП-
технологии. Любые нарушения ограничений помечаются непосредственно на 
изображении топологии, выводимом на экран дисплея, либо в окне CIW. 

DRC – это проверка топологии на соответствие физическим правилам и 
ограничениям, которые определены в специальном файле (в случае использо-
вания библиотеки gpdk таким файлом является divaDRC.rul). Результатом 
проверки является информация об ошибках и нарушениях правил в топологии. 
При этом проверяются только физические характеристики топологии и не про-
водятся никакие проверки производительности или функционирования элек-
трической схемы. 

Для выполнения DRC выбирается команда Verify → DRC в основном 
меню. После этого появляется окно программы-верификатора (рис. 3.7). 

 

 
Рис. 3.7. Параметры проверки правил проектирования 
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Необходимо убедиться, что в поле Rules File указан файл divaDRC.rul и в 
поле Rules Library указана библиотека gpdk. Для начала верификации нажи-
мается OK. 

Если существуют ошибки, то появится сообщения в окне CIW с номером 
ошибки, их количеством и описанием (рис. 3.8). В редакторе топологии на мес-
те ошибки появится мигающий многоугольник, называемый маркером ошибок. 

 

 
Рис. 3.8. Результат выполнения DRC-проверки с ошибками в топологии 

Для просмотра ошибок и получения краткого описания ошибки необхо-
димо выбрать команду Markers → Explain и нажать на маркер ошибки. Мар-
кер будет подсвечен и появится окно marker test, в котором содержится инфор-
мация об ошибке. Для выхода из команды Explain нажимается клавиша Esc. 

Для удаления маркеров ошибок необходимо выбрать команду Verify → 
Markers → Delete All. Появится окно Delete All Markers. Нажимается OK для 
подтверждения удаления. 

При наличии ошибок их исправляют и перезапускают проверку DRC. Эта 
процедура повторяется до исправления всех ошибок. Если ошибок нет, то поя-
виться соответствующее сообщение в CIW (рис. 3.9). 

 

 
Рис. 3.9. Результат успешного выполнения DRC-проверки топологии 
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Для больших сложных схем лучше использовать пошаговую процедуру 
проверки. При этом система будет хранить изменения, сделанные после по-
следней проверки DRC, и проверять только эти изменения. Это позволит вы-
полнить DRC-проверку быстрее и эффективнее, поскольку не придется обраба-
тывать всю топологию. 

Для выполнения пошаговой проверки устанавливается опция checking 
limit → incremental в окне DRC. 

3.5. Экстракция компонентов и межсоединений из топологии 

Перед тем как выполнять сравнение топологии с электрической схемой, 
необходимо провести экстракцию (восстановление) элементов соединений из 
топологического представления с помощью программы Extract. Данная про-
грамма использует правила, определенные в специальном файле, для распозна-
ния элементов, установления электрических связей и извлечения паразитных 
элементов (в случае использования библиотеки gpdk таким файлом является 
divaEXT.rul). В результате будет создано новое представление проекта. 

Запуск экстракции выполняется командой Verify → Extract. В окне 
Extractor выбирается параметр flat в поле Extract method. Используется развер-
нутый метод для экстракции значений паразитных емкостей для каждого эле-
мента в отдельности. Затем устанавливается параметр Join Nets with Same 
Name, что позволит объединить связи с одинаковыми именами, которые не 
имеют прямого электрического соединения (рис. 3.10). 
 

 
Рис. 3.10. Окно программы экстракции 
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Для выбора типа паразитных компонентов, которые необходимо экстра-
гировать, нажимается кнопка Set Switches в окне Extractor. В новом окне Set 
Switches выбираются параметры экстракции паразитов, которые доступны для 
конкретной технологии. Для подтверждения нажимается OK. В данном задании 
рекомендуется провести экстракцию два раза: с параметром PARASITIC_C 
(паразитные емкости) и PARASITIC_RC (паразитные емкости и сопротивле-
ния). При этом следует указать различные названия для экстрагированных 
представлений. Это необходимо для последующего моделирования и оценки 
влияния паразитных элементов (только емкости, емкости и резисторы) на ха-
рактеристики инвертора. 

Для создания экстрагированного представления нажимается OK или Ap-
ply в окне Extractor. В CIW отобразится результат выполнения программы 
Extract (рис. 3.11). 

 

 
Рис. 3.11. Результат успешного выполнения экстракции из топологии 

Необходимо убедиться, что восстановление прошло успешно. После за-
вершения будет создано новое представление с именем extracted. Его можно 
открыть, используя менеджер библиотек (рис. 3.12, а, б). 

Откроется окно, в котором отображено экстрагированное представление 
ячейки. Экстрагированное представление сходно с топологическим, только 
транзисторы отображаются как символы с указанием размеров. Кроме того, 
отображаются паразитные резисторы и емкости. 

Для просмотра электрических соединений в меню Display Options выби-
рается опция Nets. Би

бл
ио
те
ка

 БГ
УИ
Р



 52

 
а 

 
б 

Рис. 3.12. Результаты экстракции: 
а – с параметром PARASITIC_C; б – с параметром PARASITIC_RC 
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3.6. Проверка топологии на соответствие электрической схеме 

Программа LVS выполняет сравнение топологического представления 
проекта с его исходной электрической схемой. LVS использует для сравнения 
электрическую схему (schematic view) и экстрагированное из топологии пред-
ставление схемы (extracted view). Запускается с помощью команды Verify → 
LVS (рис. 3.13). 

Если появляется окно LVS Form Contents Different, нажимаем OK для 
продолжения. В окне LVS заполняются поля schematic и extracted с использо-
ванием кнопок Browse или Sel by Cursor. Если оба представления schematic и 
extracted открыты перед появлением окна LVS, то соответствующие поля 
должны быть заполнены автоматически. Необходимо проверить настройки 
Rules File = divaLVS.rul и Rules Library = gpdk (в случае использования биб-
лиотеки gpdk) и отключить опцию Correspondence File. Эта опция позволяет 
вручную указать соответствие между элементами схемы и топологии. 

Для запуска проверки необходимо нажать Run. Если появится окно Save 
cellview, нажимаем OK. LVS выполняется в теневом режиме и занимает опре-
деленное время в зависимости от сложности схемы. Когда проверка выполнена, 
появляется окно Analysis Job Succeeded. Это означает, что программа успешно 
завершила все процедуры, но не значит, что топология соответствует схеме. 

Для просмотра результатов нажимается Output в окне LVS. Появится ок-
но с результатами работы LVS (рис. 3.14), в котором отображены результаты 
сравнения и приведена статистика по элементам, связям, портам и т. д. 
 

 
Рис. 3.13. Окно программы LVS 
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Если электрическая схема соответствует топологии, отчет будет содер-
жать следующую строку: 

The net-lists match (рис. 3.14), 
если не соответствует: 
The net-lists failed to match. 
Если сравнение прошло неудачно, необходимо поправить топологию, 

провести экстракцию и запустить сравнение повторно. 
 

 
Рис. 3.14. Результат успешного выполнения проверки LVS 

Просмотр ошибок сравнения 
Для просмотра ошибок следует открыть представление extracted и нажать 

кнопку Error Display в нижней части окна LVS. 
Появится окно LVS Error Display, затем нажимается кнопка First в сек-

ции Display. Появится сообщение об ошибке ниже секции Display. Также в 
представлении extracted будет подсвечено несоответствие с помощью цвета, 
указанного в поле Error Color. Для сброса подсветки используют кнопку Clear 
Display в окне LVS Error Display. 
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Если топология не совпадает со схемой, то для нахождения ошибки мо-
жет помочь процедура зондирования (probing). Для этого нажимается кнопка 
Probe Form в окне LVS Error Display. 

В окне Probing изменяется Probing Method в cross probe, затем выбира-
ется Add Device или Net. Затем указывается элемент или связь в окне extracted 
или schematic. Соответствующий элемент (или связь) будет подсвечен в другом 
окне. В качестве альтернативы можно ввести имя элемента или связи в кавыч-
ках в CIW, и они должны быть подсвечены в обоих окнах. 

Единичное зондирование выполняется аналогичным образом после изме-
нения Probing Method в single probe. Эта опция полезна для поиска ошибок, 
когда заданы имена элементов или связей в LVS. 

Для удаления маркеров используется кнопка Remove All в окне Probing. 

3.7. Моделирование схемы с учетом паразитных элементов 

Для проведения моделирования схемы с учетом паразитных элементов 
необходимо создать новое представление тестовой схемы инвертора, которое 
называется config. 

Выбирается команда File → New → Cell View. В появившемся окне в по-
ле Tool выбирается Hierarchy-Editor и нажимается OK. Появятся два окна. В 
окне New Configuration в поле View выбирается schematic, нажимается Use tem-
plate и в поле Name выбирается программа моделирования spectre. По заверше-
нии нажимается OK (рис. 3.15). 
 

 
Рис. 3.15. Пример создания новой конфигурации 
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Затем выбирается параметр View to Use для ячейки инвертора schematic, 
обновляется конфигурация (рис. 3.16) и закрывается Cadence hierarchy editor. 

В менеджере библиотек в колонке View необходимо открыть представле-
ние config, в появившемся окошке выбрать yes для всех полей. После этого от-
кроется схема и редактор иерархии Cadence hierarchy editor, в котором можно 
изменять представления для моделирования: schematic, extracted и другие 
имеющиеся. 

В данном примере рекомендуется провести моделирование представле-
ний schematic, extracted_c, extracted_rc, вычислить задержку распространения 
сигнала и проанализировать влияние паразитных компонентов. По возможно-
сти провести оптимизацию топологии с целью снижения задержки сигнала. 
 

 
Рис. 3.16. Настройка конфигурации проекта с использованием 

Cadence hierarchy editor 
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4. ИНДИВИДУАЛЬНЫЕ ЗАДАНИЯ ДЛЯ ЛАБОРАТОРНЫХ РАБОТ 

Порядок выполнения заданий. 
1. Собрать электрическую схему и провести моделирование с вычислени-

ем ключевых параметров. 
2. Разработать топологию электрической схемы. 
3. Провести проверку конструкторско-технологических требований к 

проектированию топологии (DRC). 
4. Провести экстракцию паразитных элементов. 
5. Провести сравнение топологии с электрической схемой (LVS). 
6. Провести моделирование схемы с учетом паразитных элементов (post-

layout simulation). 
7. Сравнить полученные результаты post-layout-моделирования с резуль-

татами моделирования электрической схемы. 
 

Таблица 4.1 
 

Аналоговые схемы, рекомендуемые для лабораторных работ и курсового проектирования 
Схема 

(№ рис.) 
R1, 
кОм 

R2, 
кОм 

R3, 
кОм 

R4, 
кОм 

R5, 
кОм 

R6, 
кОм 

R7, 
кОм 

С1, 
пФ 

С2, 
пФ 

1 5,6 0,1 4,0 4,0 1,8 0,4 5,6 3000 – 
2 4,0 4,0 1,2 4,0 1,7 – – 1500 1000 
3 4,0 1,8 4,0 4,0 1,7 5,6 – 1200 – 
4 1,4 5,6 9,8 4,0 0,6 4,8 – 1500 – 
5 4,0 5,0 1,8 4,0 2,0 1,5 – 560 – 
6 2,0 5,0 0,2 0,1 5,0 0,2 2,0 580 – 
7 4,0 5,0 1,5 0,2 2,0 1,0 – – 680 
8 10,0 4,0 2,0 10,0 1,5 1,0 – 1000 – 
9 1,0 3,0 0,5 0,6 0,6 0,5 – 560 560 
10 15,0 1,0 5,0 2,0 1,0 – – 200 680 
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Рис. 6 
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5. КОНТРОЛЬНЫЕ ВОПРОСЫ 

по дисциплине «Проектирование топологии ИМС» 
 
1. Топология ИМС, этапы проектирования топологии аналоговых схем. 
2. Маршрут проектирования топологии цифровых ИМС. 
3. Маршрут проектирования и верификации топологии в платформе 

Virtuoso (Cadence). 
4. Конструкторско-технологические требования к проектированию топо-

логии. 
5. Форматы представления топологии, спецификация слоев. 
6. Особенности топологии КМОП-транзисторов. 
7. Точность формирования топологических размеров и согласование па-

раметров МОП-транзисторов. 
8. Причины рассогласования параметров интегральных элементов и спо-

собы их устранения. 
9. Правила размещения в топологии согласованных элементов в массиве с 

общим центром. 
10. Топологические приемы уменьшения влияния температурного гради-

ента на параметры ИМС. 
11. Особенности трассировки резисторов с согласованными параметрами. 
12. Правила согласования параметров интегральных резисторов. 
13. Правила согласования параметров интегральных конденсаторов. 
14. Топологические приемы для уменьшения влияния соседних структур 

на согласование параметров элементов ИМС. 
15. Топологические методы экранирования схем от шумов по подложке. 
16. Проектирование шин питания в цифроаналоговых схемах. 
17. Компоновка топологии блоков в цифроаналоговых схемах. 
18. Топологические методы защиты от тиристорного эффекта в КМОП. 
19. Проектирование контактных площадок. 
20. Правила проектирования комбинированной КМОП-топологии. 
21. Топология интегральных конденсаторов, оптимизация параметров. 
22. Проектирование высокоомных интегральных резисторов. 
23. Проектирование интегральных резисторов с согласованным отноше-

нием номиналов. 
24. Проектирование низкоомных интегральных резисторов. 
25. Влияние паразитных элементов на характеристики ИМС. 
26. Особенности проектирования топологии аналоговых ИМС. 
27. Влияние погрешности формирования топологических размеров на ха-

рактеристики элементов ИМС. 
28. Проектирование топологии мощных биполярных транзисторов (уве-

личение рабочего напряжения и тока). 
29. Тесты для контроля технологического процесса. 
30. Тесты для контроля параметров рабочих элементов. 
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